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1. Σκοπός 

Σκοπός της παρούσας εργαστηριακής άσκησης είναι να μελετηθεί η διαμόρφωση 

μετατόπισης συχνότητας με την βοήθεια του λογισμικού προσομοίωσης AWR. Στην 

παρούσα φάση θα δοθεί έμφαση στο τμήμα του πομπού FSK, ενώ ως δραστηριότητες 

μπορείτε να υλοποιήσετε το τμήμα του δέκτη FSK. 

 

2. Προσδοκώμενα αποτελέσματα 

Όταν θα έχετε ολοκληρώσει την παρούσα εργαστηριακή άσκηση, θα: 

 Γνωρίζετε τα δομικά τμήματα ενός FSK πομπού.  

 Παραμετροποιείτε τις παραμέτρους των τμημάτων ενός FSK πομπού.  

 Λαμβάνετε μετρήσεις σε όποιο σημείο επιθυμείτε από την 

τηλεπικοινωνιακή αλυσίδα  

 Προσομοιώνετε την λειτουργία ενός FSK διαμορφωτή 

 

3. Τι θα χρειαστείτε 

Για την επιτυχή εκτέλεση της άσκησης θα χρειαστείτε τα παρακάτω: 

 Η/Υ με εγκατεστημένο το λογισμικό AWR 10.08 

 

4. Έννοιες κλειδιά 

 Ψηφιακή Διαμόρφωση 

 Διαμόρφωση μετατόπισης συχνότητας 

 Σήμα 

 Συχνότητα 

 Κυματομορφή 

 Δείκτης Διαμόρφωσης 

 

5. Εισαγωγικές Παρατηρήσεις 

Στις ψηφιακές διαμορφώσεις το σήμα πληροφορίας που διαμορφώνεται είναι σε ψηφιακή 

μορφή. Οι κυριότερες μέθοδοι των ψηφιακών διαμορφώσεων είναι: 

 Διαμόρφωση μετατόπισης συχνότητας (FSK) 

 Διαμόρφωση μετατόπισης πλάτους (ASK)  

http://el.wikipedia.org/wiki/%CE%A8%CE%B7%CF%86%CE%B9%CE%B1%CE%BA%CF%8C_%CF%83%CE%AE%CE%BC%CE%B1
http://el.wikipedia.org/wiki/%CE%A8%CE%B7%CF%86%CE%B9%CE%B1%CE%BA%CF%8C_%CF%83%CE%AE%CE%BC%CE%B1
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%BC%CF%8C%CF%81%CF%86%CF%89%CF%83%CE%B7_%CE%BC%CE%B5%CF%84%CE%B1%CF%84%CF%8C%CF%80%CE%B9%CF%83%CE%B7%CF%82_%CF%83%CF%85%CF%87%CE%BD%CF%8C%CF%84%CE%B7%CF%84%CE%B1%CF%82
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%BC%CF%8C%CF%81%CF%86%CF%89%CF%83%CE%B7_%CE%BC%CE%B5%CF%84%CE%B1%CF%84%CF%8C%CF%80%CE%B9%CF%83%CE%B7%CF%82_%CF%80%CE%BB%CE%AC%CF%84%CE%BF%CF%85%CF%82
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 On Off Keying (OOK) 

 Διαμόρφωση μετατόπισης φάσης (PSK) 

 Quadrature Amplitude Modulation (QAM) 

Διαμόρφωση μετατόπισης συχνότητας (Frequency-shift Keying - FSK) ονομάζεται ο τύπος 

διαμόρφωσης σήματος όπου ψηφιακά δεδομένα παρουσιάζονται ως αλλαγές στη 

συχνότητα ενός φέροντος σήματος. 

Τα περισσότερα από τα πρώτα μοντέλα modem χρησιμοποιούσαν διαμόρφωση FSK για να 

στείλουν και να λάβουν δεδομένα με ρυθμούς μέχρι 300, 600 ή 1200 bits το δευτερόλεπτο 

(συστάσεις I.T.U. V21 και V.23[1]). Μερικοί μικρο-υπολογιστές χρησιμοποιούσαν μια ειδική 

μορφή διαμόρφωσης FSK, το πρότυπο Kansas City, για αποθήκευση δεδομένων σε κασέτες 

ήχου. Η διαμόρφωση FSK χρησιμοποιείται ακόμη στο ερασιτεχνικό ραδιόφωνο γιατί 

επιτρέπει μεταφορά δεδομένων από μη τροποποιημένο εξοπλισμό για μετάδοση φωνής. 

 

Παράδειγμα  Διαμόρφωσης FSK 

 

6. Πείραμα: Μετάδοση με Διαμόρφωση Μετατόπισης 
Συχνότητας (FSK)  

Σε αυτό το πείραμα φτιάχνουμε και κάνουμε εξομοίωση μιας πλήρους αλυσίδας πομπού- 

καναλιού μετάδοσης – δέκτη σήματος για  μια δυαδική μετάδοση διαμόρφωσης 

μετατόπισης συχνότητας (BFSK). Το παράδειγμα επιδεικνύει πώς να φτιάξουμε μια πηγή 

διαμόρφωσης μετατόπισης συχνότητας (FSK) χρησιμοποιώντας βασικά block ή ένα “μαύρο 

http://el.wikipedia.org/w/index.php?title=On_Off_Keying&action=edit&redlink=1
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%BC%CF%8C%CF%81%CF%86%CF%89%CF%83%CE%B7_%CE%BC%CE%B5%CF%84%CE%B1%CF%84%CF%8C%CF%80%CE%B9%CF%83%CE%B7%CF%82_%CF%86%CE%AC%CF%83%CE%B7%CF%82
http://el.wikipedia.org/w/index.php?title=Quadrature_Amplitude_Modulation&action=edit&redlink=1
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%BC%CF%8C%CF%81%CF%86%CF%89%CF%83%CE%B7_%CF%83%CE%AE%CE%BC%CE%B1%CF%84%CE%BF%CF%82
http://el.wikipedia.org/wiki/%CE%A3%CF%85%CF%87%CE%BD%CF%8C%CF%84%CE%B7%CF%84%CE%B1
http://el.wikipedia.org/wiki/%CE%A6%CE%AD%CF%81%CE%BF%CE%BD_%CF%83%CE%AE%CE%BC%CE%B1
http://el.wikipedia.org/wiki/%CE%94%CE%B9%CE%B1%CE%BC%CF%8C%CF%81%CF%86%CF%89%CF%83%CE%B7_%CE%BC%CE%B5%CF%84%CE%B1%CF%84%CF%8C%CF%80%CE%B9%CF%83%CE%B7%CF%82_%CF%83%CF%85%CF%87%CE%BD%CF%8C%CF%84%CE%B7%CF%84%CE%B1%CF%82#cite_note-1
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κουτί» διαμορφωτή FSK (αποκαλούμενο FSK_SRC) σε VSS. Δεν είναι πάντα απαραίτητο να 

κατασκευαστεί ένας δέκτης και ένα πομπός χρησιμοποιώντας τα βασικά block. Για πολλές 

κοινές μεθόδους διαμόρφωσης, τα αντίστοιχα μαύρα κουτιά υπάρχουν ήδη στο VSS. Αυτή η 

άσκηση, εντούτοις, προορίζεται να δείξει ότι η χρησιμοποίηση του μαύρου κουτιού ή η 

δημιουργία ενός που χρησιμοποιεί τα βασικά block  παράγει τα ίδια αποτελέσματα. Θα 

κατασκευάσετε επίσης έναν FSK αποδιαμορφωτή χρησιμοποιώντας τα βασικά block, και θα 

ελέγξετε την απόδοση του συστήματος με τον καθορισμό των διαφορετικών παραμέτρων.  

Οι διαδικασίες σε αυτό το παράδειγμα περιλαμβάνουν:  

  Έλεγχο της BFSK κυματομορφής που παράγεται χρησιμοποιώντας διαφορετικές 

μεθόδους 

  Διαβάθμιση καναλιού και θορύβου και απόδοση συστήματος 

  Παρακολούθηση των BER και sweep στατιστικών σε ένα παράθυρο κειμένου   

Στην εργασία αυτή λοιπόν θα φτιάξουμε ένα project και το BFSK διάγραμμα συστήματος, 

μετά θα χρησιμοποιήσουμε τον FSK modulator (FSK_SRC) και θα σχεδιάσουμε το φάσμα 

ισχύος (power spectrum) του διαμορφωμένου σήματος.  

 

ΣΗΜΕΙΩΣΗ: Το AWRDEQuick Reference document έχει τα keyboard shortcuts, τις λειτουργίες 

ποντικιού, και tips και tricks για βελτιστοποίηση της χρήσης του AWRDE. Επιλέξτε Help > 

Quick Reference για να έχετε πρόσβαση στο έγγραφο. 

6.1 Δημιουργία Project 
Βήμα 1ο: Πάμε στο File>New Project 

Βήμα 2ο: Επιλέγουμε File > Save Project As. Το παράθυρο διαλόγου Save As εμφανίζεται 

Βήμα 3ο: Επιλέγουμε τον φάκελο στον οποίο θέλουμε να αποθηκεύσουμε το Project. 

Βήμα 4ο: Δίνουμε μία ονομασία της επιλογής μας, π.χ. “ bfsk” το νέο Project, στο 

παράθυρο διαλόγου που εμφανίζεται. Αποθηκεύουμε πατώντας Save. 

Σημείωση: Συνίσταται να αποθηκεύουμε κάθε νέο Project σε ξεχωριστό φάκελο. 

6.2 Ορισμός καθολικών ρυθμίσεων συστήματος 
Πριν δημιουργήσουμε μια προσομοίωση πρέπει να ορίσουμε τις καθολικές ρυθμίσεις του 

συστήματος. Για να  τις ορίσουμε κάνουμε τα εξής βήματα: 

1. Από το οριζόντιο μενού επιλέγουμε Options> Project Options 

2. Πηγαίνουμε στην καρτέλα Global Units και επιβεβαιώνουμε ότι οι ρυθμίσεις 

αντιστοιχούν με αυτές που δίνονται στην Εικόνα 3. 

3. Πατάμε ΟΚ για να αποθηκεύσουμε τις ρυθμίσεις. 
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Εικόνα 3 – Ορισμός προκαθορισμένων ρυθμίσεων συστήματος 

6.3 Δημιουργία διαγράμματος συστήματος 
Το διάγραμμα συστήματος είναι το πλέον βασικό τμήμα του περιβάλλοντος εργασίας, 

καθώς αποτελεί τον καμβά στον οποίο χτίζουμε εξ’ ολοκλήρου (end-to-end) τα  συστήματα 

επικοινωνιών και υλοποιούμε αλγορίθμους με γραφικό τρόπο χρησιμοποιώντας τα block 

συμπεριφοράς (behavioralblocks) του VSS. Ένα VSS project μπορεί να περιλαμβάνει 

πολλαπλά διαγράμματα  συστήματος, γραμμικά και μη-γραμμικά σχηματικά, και netlists. 

Για να δημιουργήσουμε ένα διάγραμμα συστήματος: 

1. ΕπιλέγουμεProject>Add System Diagram > New System Diagram. Εμφανίζεται το 

παράθυρο διαλόγου του νέου διαγράμματος συστήματος 

2. Πληκτρολογούμε “ CP_BFSK ” και πατάμε Create. Ένα παράθυρο διαγράμματος 

συστήματος εμφανίζεται στον χώρο εργασίας (workspace) και το “ CP_BFSK ” 

διάγραμμα συστήματος εμφανίζεται κάτω από τα System Diagrams στον πλοηγό 

Project. 

  

6.4 Προσθήκη Block στο διάγραμμα συστήματος 
 

Για να δημιουργήσουμε μια FSK source χρησιμοποιώντας έναν "black box" FSK 

διαμορφωτή: 

Στον  Element Browser στη λίστα System Blocks, πατήστε το + στην κατηγορία Modulation, 

και επιλέξτε το FSK subgroup. Επιλέξτε το FSK_SRC block και τοποθετήστε το πάνω στο 

system diagram. Επιβεβαιώστε ότι οι παράμετροί του έχουν τις ακόλουθες τιμές και μετά 

πατήστε OK.  
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6.5 Προσθήκη Ελέγχου και Εξομοίωση 
1. Πρόσθεσε  από Meters και σύνδεσε ένα test point όπως δείχνει το ακόλουθο 

σχήμα.  

 

2. Πρόσθεσε ένα rectangular graph με το όνομα "Spectrum".  
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3. Πρόσθεσε μέτρηση στο γράφο χρησιμοποιώντας τις ρυθμίσεις της ακόλουθης 

εικόνας και πάτησε ΟΚ. 

 

4. Τρέξε τον Εξομοιωτή Συστήματος και σταμάτησέ τον μετά από λίγα λεπτά. Το power 

spectrum του FSK σήματος που παράχθηκε από το block εμφανίζεται όπως στο 

γράφημα που ακολουθεί.  
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7. ΔΗΜΙΟΥΡΓΩΝΤΑΣ ΕΝΑΝ FSK MODULATOR 
ΧΡΗΣΙΜΟΠΟΙΩΝΤΑΣ ELEMENTARY BLOCKS 

 
Τώρα θα δημιουργήσουμε έναν BFSK modulator χρησιμοποιώντας elementary blocks, μετά 

θα συγκρίνουμε τα αποτελέσματα με αυτά της προηγούμενης μεθόδου. Αυτοί οι δύο 

διακριτοί transmitters έχουν πανομοιότυπη συμπεριφορά.  

1. Στον Element Browser, κάνουμε expand την κατηγορία Sources, μετά επιλέγουμε το 

Random subgroup. Επιλέγουμε το RND_D block και το τοποθετούμε στο CP_BFSK 

system diagram όπως στο σχήμα που ακολουθεί.  

2. Κάνουμε διπλό κλικ στο RND_D block και θέτουμε στην παράμετρο RATE την τιμή 

"1000" και στην RSEED parameter την τιμή "{0}" (μαζί με τις αγκύλες) και πατάμε 

ΟΚ.  

3. Κάνουμε Expand την κατηγορία Converters, επιλέγουμε το Analog-Digital subgroup. 

Επιλέγουμε το DAC block και το τοποθετούμε πάνω στο διάγραμμα συστήματος 

όπως φαίνεται στο σχήμα που ακολουθεί. Αφήνουμε σε αυτό την παράμετρο 

SMPSYM ως  _SMPSYM. Η SMPSYM παίρνει αυτόματα την τιμή 8. Δηλαδή 8 

δείγματα ανά σύμβολο είναι η default ρύθμιση που ορίζεται στο Simulator. 

Επιπλέον, η έξοδος από το DAC είναι ένα πραγματικό σήμα με 8 δείγματα ανά bit 

και με  rate  1KHz.  

4. Κάνε Expand την κατηγορία Modulation, μετά επέλεξε το Analog subgroup. Επέλεξε 

το FM_MOD block και τοποθέτησέ το πάνω στο διάγραμμα συστήματος όπως στο 

σχήμα που ακολουθεί.  

5. Θέσε στην παράμετρο KF του  FM_MOD block την τιμή "353.5" = (0.707/2*1000).  

6. Κάνε Expand την κατηγορία Sources, μετά επέλεξε το Waveforms subgroup. Επέλεξε 

το SINE block και τοποθέτησέ το όπως στο σχήμα που ακολουθεί.  

7. Θέσε την τιμή "5" στην παράμετρο AMPL του SINE block. Άφησε την FRQ parameter 

στο 1GHz.  

8. Πρόσθεσε από τις METERS ένα δεύτερο test point με το όνομα "BFSK" στο σύστημα 

όπως φαίνεται στο σχήμα που ακολουθεί.  
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9. Πήγαινε στο Spectrum Graph και κάνε Add Measurement και στο Measurement 

Type πήγαινε System > Spectrum category of measurements, πρόσθεσε ένα power 

spectrum measurement (PWR_SPEC) στο test point BPSK στον "Spectrum" graph.  

10. Τρέξε τον Εξομοιωτή Συστήματος. Πρόσεξε ότι δεν υπάρχει αλλαγή στο γράφο 

εφόσον η κυματομορφή από το cascade αυτών των block είναι όμοια με την 

κυματομορφή του FSK_SRC block και γίνεται επικάλυψη.  

Για να δεις το spectrum από κάθε setup ξεχωριστά, μπορείς να τα εμφανίσεις σε 

ξεχωριστούς γράφους ή να αλλάζεις τις μετρήσεις μια κάθε φορά κάτω από το 

Graphs στον Project Browser (δεξί κλικ και επιλέγεις Toggle Enable). Αυτά τα 

βήματα επιβεβαιώνουν ότι οι δύο μέθοδοι ρύθμισης ενός πομπού παράγουν 

όμοιες κυματομορφές BFSK.  

11. Πρόσθεσε ένα τρίτο test point με το όνομα "Data" ανάμεσα στο RND_D block και το 

DAC block.  

Για να παρατηρήσεις τη συμπεριφορά της μεταδιδόμενης φάσης:  

12. Πρόσθεσε έναν rectangular graph με το όνομα "TX Waveforms".  

13. Πρόσθεσε μια μέτρηση time domain waveform measurement στον graph  TX 

Waveforms χρησιμοποιώντας τις ρυθμίσεις της ακόλουθης εικόνας και επέλεξε 

Apply/ΟΚ.  
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14. Πρόσθεσε μια μέτρηση στον graph ΤΧ Waveforms για την φάση που παράγεται από 

τον FSK modulator χρησιμοποιώντας τις ρυθμίσεις του βήματος 13, αλλά επέλεξε 

BFSK ως Test Point και Angle ως Complex Modifier, μετά  επέλεξε OK.  

15. Επέλεξε τον "TX Waveforms" graph και επέλεξε τα Properties πατώντας δεξί κλικ 

στον graph και επιλέγοντας Properties.  

16. Επέλεξε την καρτέλα Axes και επέλεξε Left 1. Καθάρισε το Auto limits check box και 

βάλε "-1" ως Min και "2" ως Max. Κάτω από το Divisions, καθάρισε το Auto divs. 

check box και βάλε "1" ως  Step.  

17. Επέλεξε Right 1. Καθάρισε το Auto limits check box και βάλε "-200" ως Min και 

"200" ως Max, και επέλεξε Apply.  

18. Επέλεξε την καρτέλα Measurements και κάτω από το Select Measurement to edit, 

επέλεξε BFSK:Ang(WVFM(TP.BFSK,20,3,1,0,0,0,0,0)],  μετά κάτω από τον άξονα 

Choose axis, επέλεξε Right 1 και μετά Apply.  
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19. Επέλεξε την καρτέλα Traces και κάτω από το Style, επέλεξε measurement 1 (το 

μπλέ), κάτω από το Measurement επέλεξε μια εντονότερη γραμμή από το drop-

down box στο κάτω μέρος του dialog box. Επέλεξε measurement 2 (φούξια), μετά 

επέλεξε ένα τετράγωνο (square) ως Symbol style από το αντίστοιχο drop-down box 

box στο κάτω μέρος του dialog box  και πάτησε APPLY. 

20. Τρέξε τον εξομοιωτή του συστήματος. Παρατήρησε ότι η μεταδιδόμενη φάση 

συμπεριφέρεται ακριβώς όπως αναμέναμε σε ένα binary FSK transmission scheme 

με rectangular frequency shaping pulse.  

Η ανταπόκριση της εξομοίωσης πρέπει να δείχνει παρόμοια με τον ακόλουθο 

γράφο, που δείχνει την phase της διαμορφωμένης κυματομορφής να αυξάνεται in a 

ramp όταν το input bit είναι "1", και μειώνεται in a ramp με την ίδια κλίση όταν το 

input bit είναι "0". Η φάση παραμένει συνεχής μεταξύ διαφορετικών διαστημάτων 

bit και τα άλματα φάσης στο σχεδιάγραμμα είναι μόνο η επίδραση του wrap-

around όταν η φάση ξεπερνά τους +/- 180-βαθμούς. Οι κυματομορφές δεδομένων 

(των δυαδικών 1 and 0) αναπαρίσταται στον αριστερό άξονα ενώ η κυματομορφή 

της φάσης φαίνεται στο δεξί άξονα. 
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8. ΔΕΚΤΗΣ ΚΑΙ ΑΠΟΔΙΑΜΟΡΦΩΣΗ 

 

Εδώ ολοκληρώνουμε την αλυσίδα καναλιού-δέκτη για το BFSK. Ο δέκτης δημιουργείται από 

elementary VSS blocks για λόγους επίδειξης και τον κάνουμε για λόγους επίδειξης και το 

δείχνουμε για να αποδείξουμε ακόμα και την ακρίβεια του BFSK demodulator. Το 

διαμορφωμένο σήμα εκτός του πομπού περνά μέσα από ένα AWGN κανάλι και μετά 

αποδιαμορφώνεται από ένα δέκτη εξακρίβωσης, που αποτελείται από ένα φίλτρο (PLSSHP), 

έναν FM discriminator (FM_DSCRM), ένα integrate-and-dump block (INTG_DMP), και ένα 

ADC block. Σε αυτή την άσκηση μπορείς επίσης να πειράξεις τις παραμέτρους καναλιού και 

θορύβου και να αναλύσεις την επίδοση του συστήματος.  

Για να ολοκληρώσουμε την αλυσίδα κανάλι-δέκτη για BFSK (χρησιμοποιώντας την 

ακόλουθη εικόνα ως αναφορά):  

1. Στον Element Browser, επιλέγουμε την κατηγορία Channels. Επιλέγουμε το AWGN 

block και το τοποθετούμε στο CP_BFSK system diagram.  

2. Επιλέγουμε την κατηγορία Filters, μετά επιλέγουμε το PLSSHP block και το 

τοποθετούμε στο system diagram.  

3. Κάνουμε Expand την κατηγορία Modulation, μετά επιλέγουμε το Analog subgroup. 

Επιλέγουμε το FM_DSCRM block και το τοποθετούμε στο system diagram.  

4. Επιλέγουμε την κατηγορία Signal Processing, μετά επιλέγουμε το  INTG_DMP block 

και το τοποθετούμε στο system diagram.  

5. Κάνουμε Expand την κατηγορία Converters, μετά επιλέγουμε  το Analog-Digital 

subgroup. Επιλέγουμε το ADC block και το τοποθετούμε στο system diagram.  

6. Προσθέτουμε ένα 4ο, 5ο και 6ο test point στις εξόδους των FM_DSCRM, INTG_DMP 

και ADC blocks αντίστοιχα, και τα ονομάζουμε αντίστοιχα "Discrim", "INT_Dump", 

και "ADC" όπως στην ακόλουθη εικόνα.  

7. Επιλέγουμε την κατηγορία Signal Processing, μετά επιλέγουμε το ALIGN block και το 

τοποθετούμε στο system diagram. Συνδέστε τον κόμβο 2 στο ADC test point.  

8. Κάνουμε Expand την κατηγορία Meters, μετά επιλέγουμε το BER subgroup. Επέλεξε 

το BER_EXT block και το τοποθετούμε στο system diagram.  
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9. Προσθέστε την ακόλουθη equation στο system diagram: 

Eb_No = sweep(stepped(1,13,2))  

10. Βάλε στην παράμετρο του AWGN block PWR την τιμή "-Eb_No" και όρισε την 

PWRTYP παράμετρο σε Normalized N0/2(dBW/Hz).  

11. Όρισε στο PLSSHP block την παράμετρο PLSTYP σε Gaussian (BT), την παράμετρο 

NRMTYP σε Unit Pulse Gain, και την παράμετρο ALPHA σε "0.5".  

12. Όρισε στο FM_DSCRM block την παράμετρο GAIN σε "1/353.5".  

13. Όρισε στο INTG_DMP block την παράμετρο Ν σε "8". Θυμήσου ότ η DAC ορίσθηκε 

σε 8 samples ανά symbol.  

14. Θέσε στο ADC block την παράμετρο M σε "2".  

15. Στην καρτέλα  Parameters του ALIGN block, θέσε την GAINCOMP σε None, την 

PHSCOMP σε Reversal μόνο, και άσε την DLYCOMP σε Yes. Το ALIGN block 

χρησιμοποιείται για να αντιστοιχίσει τα πρωτότυπα δεδομένα με τα ληφθέντα, πριν 

τον BER detector.  

16. Επιβεβαίωσε ότι οι παράμετροι του BER_EXT block είναι ίδιες με αυτές της 

επόμενης εικόνας.  
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9. ΠΡΟΣΘΗΚΗ ΓΡΑΦHMATΩΝ ΚΑΙ ΑΝΑΛΥΣΗ 
ΑΠΟΤΕΛΕΣΜΑΤΩΝ 

 

 

Για να προσθέσεις και να αναλύσεις ένα γράφημα κυματομορφής RX πρέπει να: 

1. Πρόσθεσε έναν rectangular graph με το όνομα "RX Waveforms".  

2. Πρόσθεσε μια μέτρηση στο γράφημα χρησιμοποιώντας τις ρυθμίσεις της επόμενης 

εικόνας, και μετά επέλεξε Apply.  

3. Επανέλαβε το βήμα 2 αλλά επέλεξε το TP.INT_DUMP ως Test Point.  

4. Επανέλαβε το βήμα 2 αλλά επέλεξε το TP.ADC ως Test Point, μετά επέλεξε OK.  

5. Τρέξε τον System Simulator για μερικά λεπτά και μετά σταμάτησέ τον. Ένα 

στιγμιότυπο της απόκρισης του εξομοιωτή φαίνεται στον ακόλουθο γράφο. Ο 

γράφος σας πρέπει να είναι παρόμοιος αφού κάνετε τις απαραίτητες αλλαγές στα 

property των trace και axis στο Graph Properties dialog box. Θέστε την 

κυματομορφή στο testpoint TP.INT_DUMP για να εμφανίζεται στο δεξί άξονα.  
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6. Ανέλυσε το γράφο. Η έντονη κυματομορφή είναι η έξοδος του FM discriminator σε 

low noise. Το δείγμα εξόδου του integrate-and-dump block κάθε 1 msec ή 1e6 nsec 

(το sample στο symbol rate των 1000 samples/sec) εμφανίζετε με ένα τριγωνικό 

σημάδι. Όπως αναμενόταν, η καμπύλη είναι θετική όταν η έξοδος του FM 

discriminator αυξάνεται, αλλιώς είναι αρνητικη. Επίσης παρατηρήστε την έξοδο του 

ADC block, καθώς τέμνεται με την έξοδο του integrate-and-dump block για 

ψηφιακά δεδομένα εξόδου. Η κλίμακα για την έξοδο integrate-and-dump είναι στο 

δεξιό y-άξονα, και αυτή για τον FM discriminator και τον ADC είναι στον αριστερό y-

άξονα.  
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7. Πρόσθεσε έναν ακόμα rectangular graph με το όνομα "BER".  

8. Πρόσθεσε μια μέτρηση στο graph χρησιμοποιώντας τις ρυθμίσεις της ακόλουθης 

εικόνας και μετά επέλεξε Apply.  

 

9. Πρόσθεσε μια ακόμα μέτρηση στο graph που αναπαριστά την επίδοση ενός non-

coherent δέκτη, χρησιμοποιώντας τις ρυθμίσεις της ακόλουθης εικόνας και επέλεξε 

Apply.  
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10. Επανέλαβε το βήμα 9 αλλά επέλεξε Coherent ως Demodulation Type. Αυτό 

αναπαριστά την επίδοση ενός coherent linear (correlation) δέκτη.  

11. Επανέλαβε το βήμα 9 αλλά επέλεξε Discriminator ως Demodulation Type και 

επέλεξε OK. Αυτό αναπαριστά την επίδοση ενός nonlinear discrimination δέκτη, υπό 

μια ιδανική υπόθεση.  

12. Θέσε στο BER_EXT block την παράμετρο TXTOUT σε Trial statistics.  

13. Τρέξε τον System Simulator. Ένα παράθυρο κειμένου εμφανίζει τα στατιστικά της 

BER simulation.  

14. Επέλεξε το παράθυρο του BER graph, μετά επέλεξε το Properties button στη 

γραμμή εργαλείων. Επέλεξε τις καρτέλες Traces και Axes και κάνε τις απαραίτητες 

αλλαγές στο γράφο σου για να δείχνει παρόμοιος με τον ακόλουθο γράφο. 

Βεβαιώσου ότι επέλεξες Log scale για τον αριστερό άξονα, και θέσε Min  "1e-7" και 

Max  "1".  
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15. Τρέξε πάλι τον System Simulator. 

16. Αποθήκευσε και κλείσε το project. 

 

10. Δραστηριότητες 

Ολοκληρώστε την εργασία υλοποιώντας τα βήματα που αφορούν το δέκτη και την 

αποδιαμόρφωση του σήματος (ενότητες 9 & 10) 

 

11. Λίστα ελέγχου γνώσεων 

Αφού ολοκληρώσατε την εκτέλεση της παρούσας εργαστηριακής άσκησης, επιστρέψτε στα 

αρχικά προσδοκώμενα αποτελέσματα και ελέγξτε κατά πόσο: 

 Γνωρίζετε τα δομικά τμήματα ενός FSK εκπομπού;  

 Μπορείτε να παραμετροποιήσετε τις παραμέτρους των τμημάτων ενός FSK 

εκπομπού;  

 Μπορείτε να λάβετε μετρήσεις σε όποιο σημείο επιθυμείτε από την 

τηλεπικοινωνιακή αλυσίδα FSK;  

 Μπορείτε να προσομοιώνετε την λειτουργία ενός FSK διαμορφωτή;. 

 



Εργαστηριακή Άσκηση 5: Διαμόρφωση Μετατόπισης Συχνότητας - FSK 
 

19 

 

12. Βιβλιογραφία-Οδηγός για περαιτέρω μελέτη 

[1] HsuH. P. (2002), Αναλογικές και Ψηφιακές Επικοινωνίες, Εκδόσεις Τζιόλα 

[2] Jayant N .S. and Noll P. (1984), Digital Coding of Waveforms: Principles and Applications 
to Speech and Video, Prentice Hall 

[3] Proakis J. G. and Salehi M. (2008), Digital Communications (5th Ed.), McGraw-Hill Higher 
Education 

[4] Prandoni P. and Vetterli M. (2008), Signal Processing for Communications, EPFL Press 
(http://www.sp4comm.org/getit.html) 

 

13. Χρήσιμοι σύνδεσμοι 

1. https://awrcorp.com/download/faq/english/docs/Getting_Started/ 

2. http://www.awrcorp.com/awrtv-player 

3. http://el.wikipedia.org/wiki/Διαμόρφωση_μετατόπισης_συχνότητας  

http://www.sp4comm.org/getit.html
https://awrcorp.com/download/faq/english/docs/Getting_Started/
http://www.awrcorp.com/awrtv-player
http://el.wikipedia.org/wiki/Διαμόρφωση_μετατόπισης_συχνότητας

